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Návod na export údajov do DXF v aplikácii QGIS 

 
Návod bol robený v aplikácii QGIS (https://www.qgis.org) verzia 3.28.3 (vydaná 28.1.2023), ktorú je 

možné spolu s ostatnými verziami stiahnuť bezodplatne na stránke https://qgis.org/downloads/. 

Užívateľská príručka anglickom jazyku:  

▪ QGIS verzia 3.28: https://docs.qgis.org/3.28/en/docs/index.html 

Ako vzorové údaje na ukážku exportu projektu do DXF boli použité údaje katastra nehnuteľností, 

ktoré sú bezodplatne dostupné na stiahnutie cez aplikáciu Atribúty katastrálneho operátu (AKO): 

https://ako.vugk.sk/. Stiahnutý Open Data vo formáte GeoPackage obsahuje vrstvy: 

• CadastralUnit - katastrálne územie, 

• ParcelC - parcely registra C, 

• ParcelE - parcely registra E, 

• Zappar - línie polohopisu. 

Podrobnejší popis štruktúry údajov je dostupný tu: https://ako.vugk.sk/Structure?s=opendata . 

Upozornenie: Priečinky a súbory, ktoré sa budú v aplikácii používať, by mali byť pomenované bez 

diakritiky a medzier, pretože niektoré nástroje s tým môžu mať problém. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

https://www.qgis.org/
https://qgis.org/downloads/
https://docs.qgis.org/3.28/en/docs/index.html
https://ako.vugk.sk/
https://ako.vugk.sk/Structure?s=opendata
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1. Pridanie do projektu 

 
Aplikácia QGIS umožňuje pracovať s vektorovými údajmi v rôznych formátoch ako napr. 

GeoPackage, ESRI Shapefile, ESRI Geodatabase. Pre pridanie vektorových údajov do projektu treba 

v hlavnom menu kliknúť na panel Layer → Add Layer → Add Vector Layer: 

 
 

Vrstvy súboru GeoPackage z AKO pridané v projekte: 
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V paneli Layers je možné meniť poradie vrstiev a tiež vrstvy premenovať po kliknutí pravým 

tlačidlom myši na vrstvu a zvolení Rename Layer: 

 
 

Názvy vrstiev je tak možné upraviť do tvaru, ako je ich potrebné zobrazovať v DXF súbore po 

exporte. 

Poznámka: prvé číslo v názve vrstvy zo súboru GeoPackage z AKO predstavuje kód katastrálneho 

územia (k.ú.), napr. 870595 je kód pre k.ú. Vrbové. 

Vrstvy po úprave názvu: 
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Po pridaní vrstvy do projektu skontrolovať nastavený súradnicový systém. V paneli Layers kliknúť 

pravým tlačidlom myši na vrstvu a vybrať Properties. V časti Source skontrolovať a nastaviť správny 

súradnicový systém vrstve po kliknutí na tlačidlo Select CRS : 

 
 

Po pridaní do projektu, tiež treba skontrolovať súradnicový systém projektu, v ktorom sa majú 

údaje zobrazovať. V prípade údajov katastra z aplikácie AKO vo formáte GeoPackage je to 

súradnicový systém S-JTSK/Krovak East North (kód EPSG:5514). 

Súradnicový systém projektu, v ktorom sa budú zobrazovať všetky vrstvy, sa dá nastaviť v ľavom 

dolnom rohu mapového okna po kliknutí na tlačidlo Current CRS : 
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Po kliknutí sa otvorí sokno Project Properties – CRS, kde treba v časti Coordinate Reference System 

vybrať požadovaný súradnicový systém po zadaní EPSG kódu 5514: 

 
 
Poznámka: Informácie o správnom nastavení súradnicových systémov a transformácií používaných 

na území Slovenska sú uvedené v návode Súradnicový systém S-JTSK[JTSK03] v QGIS  

(https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf). 

 
 

2. Konverzia polygónov na línie a alebo body 
 

V prípade potreby je možné polygónové vrstvy (napr. parcely C a E) prekonvertovať na línie 

alebo body, ktoré sa budú nachádzať vo vnútri polygónov. Takýmto spôsobom vytvorené body je 

potom možné (napr. pri vrstvách zo súboru GeoPackage z AKO) použiť pre zobrazovanie popisov 

parcelných čísel alebo prípadne aj symbolov kódu spôsobu využívania pozemku (UtilisationCode). 

Vo vytvorenom DXF potom budú popisy či symboly bodov ako samostatná vrstva, ktorej zobrazenie 

v projekte tak bude možné zapínať a vypínať podľa potreby. 

 

 

 

 

 

https://www.geoportal.sk/files/gz/s-jtsk_jtsk03_v_qgis.pdf
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Ako prvý krok urobiť kontrolu geometrie vstupných polygónov pomocou nástroja Fix geometries, 

ktorý sa nachádza v paneli Processing Toolbox → Vector Geometry: 

 
Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 

• Input layer - vybrať vstupnú polygónovú vrstvu. 

• Repair method - zvoliť metódu Linework. 

• Fixed geometries - zadať názov, formát a umiestnenie výstupného súboru. 

 
 

Líniová vrstva 

Z vytvorenej polygónovej vrstvy so skontrolovanou geometriou je možné vytvoriť línie pomocou 
nástroja Polygons to lines, ktorý sa nachádza v paneli Processing Toolbox → Vector Geometry: 
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Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 
• Input layer - vybrať vstupnú polygónovú vrstvu so skontrolovanou geometriou. 

• Lines - zadať názov, formát a umiestnenie výstupného súboru. 

 
 
Vytvorená líniová vrstva z vrstvy parciel C: 
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Bodová vrstva 

Z vytvorenej polygónovej vrstvy so skontrolovanou geometriou je možné vytvoriť body pomocou 
nástroja Point on Surface, ktorý sa nachádza v paneli Processing Toolbox → Vector Geometry: 

 
 

Po spustení nástroja treba vyplniť požadované parametre a kliknúť na tlačidlo Run: 

• Input layer - vybrať vstupnú polygónovú vrstvu so skontrolovanou geometriou. 

• Point - zadať názov, formát a umiestnenie výstupného súboru. 

 
 

Výsledná bodová vrstva z vrstvy parciel C – body sa nachádzajú vo vnútri polygónov parciel: 

 
 



11 
 

3. Nastavenie symboliky 
 

Pred exportom projektu do DXF je možné nastaviť požadovanú symboliku jednotlivých vrstiev.  
Po exporte do DXF sa zachová napr. farba a hrúbka čiar, jednoduchá farebná výplň polygónov, 
farba a jednoduchý symbol bodov. 
Podrobnejšie o nastavení symboliky vrstiev v QGIS : 
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/vector_properties.html#symbology
-properties 
 
Po pridaní vektorových vrstiev do projektu sa im automaticky nastaví symbolika, ktorú je možné 

následne upraviť v paneli Symbology po kliknutí pravým tlačidlom na vrstvu v paneli Layers a zvolení 

Properties: 

 
 

Tam v hornej časti panela Symbology je možné zvoliť spôsob nastavenia symboliky objektov vrstvy: 

• No Symbols - vrstva nebude mať nastavenú žiadnu symboliku. 

• Single Symbol - všetky objekty z vrstvy budú mať rovnakú symboliku pomocou jedného 
definovaného symbolu. 

• Graduated - symbolika objektov z vrstvy sa vykresľuje pomocou definovaného symbolu, 
ktorého farba alebo veľkosť sa môžu meniť podľa hodnôt vybraného atribútu. 

• Cathegorized alebo Rule-based - symbolika objektov z vrstvy sa vykresľuje pomocou 
definovaného symbolu alebo symbolov, ktoré sa môžu meniť podľa zvoleného atribútu či 
atribútov alebo iných zvolených podmienok. 

 

https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/vector_properties.html#symbology-properties
https://docs.qgis.org/3.28/en/docs/user_manual/working_with_vector/vector_properties.html#symbology-properties
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Polygónová vrstva 

Príklad nastavenia symboliky pre polygónovú vrstvu parciel C z AKO: 

a) Single Symbol 

Možné upravovať napr. typ symbolu vrstvy (Symbol layer type), farbu výplne polygónu (Fill color), 

typ výplne polygónu (Fill style), farbu hranice polygónu (Stroke color), hrúbku hranice polygónu 

(Stroke width) a typ symbolu hranice polygónu (Stroke style). 

 

Polygón s jednoduchou farebnou výplňou (Symbol layer type = Simple Fill): 
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Výsledok: 

 
 

Polygón bez výplne (Symbol layer type = Simple Line): 
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Výsledok: 

 
 

 

b) Cathegorized podľa atribútu NatureOfLandUseCode (kód druhu pozemku) 

V časti Color ramp je možné vybrať farebnú škálu, podľa ktorej sa nastaví farba symbolov. 

Úprava symbolu každej kategórie je možné upraviť po dvojitom kliknutí myši na symbol v stĺpci 

Symbol, po čom sa otvorí okno Symbol Selector, kde je možné upravovať napr. typ symbolu (Symbol 

layer type), farbu výplne polygónu (Fill color), typ výplne polygónu (Fill style), farbu hranice polygónu 

(Stroke color), hrúbku hranice polygónu (Stroke width) a typ symbolu hranice polygónu (Stroke 

style). 
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Názov kategórie symbolu je možné upraviť v stĺpci Legend: 

 
 

Výsledok: 
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Líniová vrstva 

Príklad nastavenia symboliky pre líniovú vrstvu Zappar z AKO: 

a) Single Symbol 

Možné upravovať typ symbolu vrstvy (Symbol layer type), farbu (Color), hrúbku línie (Stroke width) 

a typ symbolu línie (Stroke style). 

 
 

Výsledok: 
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Bodová vrstva 

Príklad nastavenia symboliky pre bodovú vrstvu vytvorenú z vrstvy parciel C z AKO podľa postupu  

z 2. kapitoly: 

a) Single Symbol 

Možné upravovať typ symbolu vrstvy (Symbol layer type), veľkosť (Size), farbu výplne (Fill Color), 

farbu hranice symbolu (Stroke color), typ symbolu hranice symbolu (Stroke style), hrúbku hranice 

symbolu (Stroke width), natočenie symbolu (Rotation), posun symbolu od prislúchajúceho bodu 

(Offset), vzťažný bod umiestnenia symbolu (Anchor point). 

 
 

Taktiež je možné použiť aj vlastné alebo dostupné symboly z QGIS vo formáte SVG. 

SVG súbory so značkami druhu pozemku a spôsobu využívania pozemku z usmernenia 

https://www.gku.sk/files/sk/slovensky/ugkk/kataster-nehnutelnosti/technicke-predpisy-ine-akty-

riadenia/usm_ugkk-sr_13_2013.pdf je možné stiahnuť tu: 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip   

Po stiahnutí ich treba nakopírovať do priečinka (príklad pre QGIS verzia 3.28.3): C:\Program 

Files\QGIS 3.28.3\apps\qgis\svg\ . 

 

https://www.gku.sk/files/sk/slovensky/ugkk/kataster-nehnutelnosti/technicke-predpisy-ine-akty-riadenia/usm_ugkk-sr_13_2013.pdf
https://www.gku.sk/files/sk/slovensky/ugkk/kataster-nehnutelnosti/technicke-predpisy-ine-akty-riadenia/usm_ugkk-sr_13_2013.pdf
https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip
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b) Rule-based 

V paneli Symbology zvoliť možnosť Rule-based, kde je potom možné na základe hodnôt atribútov 

UtilisationCode a NatureOfLandUseCode nastaviť symboliku bodov podľa usmernenia. 

Postup: 

• V okne Symbology dvakrát kliknúť na symbol bodu: 

 
 
 
 

https://www.gku.sk/files/sk/slovensky/ugkk/kataster-nehnutelnosti/technicke-predpisy-ine-akty-riadenia/usm_ugkk-sr_13_2013.pdf
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Otvorí sa okno Edit Rule, kde do políčka Filter zadať podmienku, podľa ktorej sa bude 
bodom priraďovať symbol: 

 
 

• Potom v časti Symbol v políčku Symbol layer type vybrať SVG Marker.  

V časti SVG Browser vybrať SVG symbol prislúchajúci zadanej podmienke alebo v 

úplne spodnom políčku vybrať umiestnenie SVG súboru v počítači. 

Potom ešte nastaviť veľkosť symbolu v časti Size v políčkach Height (výška) a Width (šírka) 

a prípadne aj posun symbolu od prislúchajúceho bodu (Offset), vzťažný bod umiestnenia 

symbolu (Anchor point). V časti Scale range je ešte možné nastaviť, v rozmedzí akých 

mierok sa bude symbol v QGIS projekte zobrazovať. V políčku Label je možné zadať názov 

kategórie symbolu, ktorý sa bude zobrazovať v legende v paneli Layers: 
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Výsledné nastavenie symbolov: 
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Vstupná bodová vrstva vytvorená z polygónov parciel C z AKO: 

 
 

Výsledok po nastaven symboliky bodov so značkami: 

 
 

Vytvorený súbor QGIS QML Style File s nastavenou symbolikou bodov podľa druhu pozemku a 

spôsobu využívania pozemku z tohto návodu je možné stiahnuť tu: 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip.    

Postup ako použiť tento QML súbor s vytvorenou symbolikou je popísaný v 5. kapitole. 

 
 
 
 
 
 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip
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4. Nastavenie popisov 
 

Vrstve v projekte je možné nastaviť popisy podľa zvoleného atribútu z atribútovej tabuľky vo 

vlastnostiach vrstvy Properties → Labels, kde v hornom políčku vybrať možnosť Single Labels. Druhá 

možnosť Ruled-based Labeling sa používa napr. v prípade, ak sa popisy vrstvy v QGIS projekte majú 

meniť (veľkosť, poloha písma) podľa mierky. 

Ako prvé je treba v políčku Value vybrať atribút, ktorého hodnoty sa budú zobrazovať ako popisy 

vrstvy. V prípade parciel C a E z AKO je to atribút ParcelNumber.  

Následne je možné nastaviť: 

• V časti Text: 

o  Font -  font písma. 

o  Style – štýl písma. 

o  Size – veľkosť písma a jednotky, v akých sa bude zobrazovať vzhľadom na mierku 

v mapovom okne (Milimeters, Points, Pixels, Meters at Scale, Map Units, Inches). 

o  Color – farba písma. 
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• V časti Placement: 

o Mode – nastavenie polohy popisov vzhľadom na zodpovedajúci objekt.  

Polygónová vrstva: 

 
➢ Horizontal – popisy budú umiestnené horizontálne: 
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➢ FreeAngled) – popisy sa natočia a prispôsobia tvaru polygónu: 

 
 

Bodová vrstva: 

 
➢ Cartographic - popisy sa umiestňujú podľa pravidla ideálneho 

kartografického umiestnenia vo zvolenej vzdialenosti (Distance). 

➢ Around point - popisy sa umiestňujú v kruhu okolo objektu vo zvolenej 

vzdialenosti (Distance). 

➢ Offset from point – popisy sú umiestnené vo zvolenom kvadrante 

(Quadrant) a vzdialenosti (Offet X,Y) od bodu. 
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Ukážka: 

 
 

 

5. Uloženie a načítanie symboliky a popisov 
 

Uloženie vytvorenej symboliky a popisov vrstvy 

Nastavenú symboliku a popisy vrstvy je možné vyexportovať do súboru QGIS QML Style File. 

Vytvorenú symboliku a popisy je tak potom možné použiť aj pri ďalších vrstvách a v iných projektoch. 

Príklad polygónová vrstva parciel C z AKO s nastavenou symbolikou a popismi: 
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Nastavenú symboliku je možné vyexportovať do QML súboru po kliknutí pravým tlačidlom myši na 

vrstvu v paneli Layers a zvolení nástroja Export → Save As Layer Definition File: 

 
alebo vo vlastnostiach Properties danej vrstvy v paneli Symbology kliknúť v dolnej časti okna na 

tlačidlo Style a vybrať možnosť Save Style.  
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Následne sa otvorí okno Save Layer Style, kde v políčku Save style vybrať možnosť As QGIS QML Style 

File, v políčku File zadať názov a umiestnenie výstupného súboru, v časti Categories je možné zvoliť, 

ktoré nastavenia sa uložia do výstupného QML súboru. Pre uloženie nastavení len symboliky označiť 

Symbology: 

 
 

Pre uloženie nastavení popisov zase označiť Labels. 

Pre uloženie nastavení symboliky aj popisov súčasne označiť Symbology a Labels: 
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Načítanie vytvorenej symboliky a popisov vrstve 

 

Symboliku a popisy uložené v súbore QGIS QML Style File je možné použiť pre vrstvu v projekte tak, 

že vo vlastnostiach Properties danej vrstvy v paneli Symbology v dolnej časti okna kliknúť na tlačidlo 

Style a vybrať možnosť Load Style: 

 
 
 

Následne sa otvorí okno Database Styles Manager, kde v políčku Load style vybrať možnosť From 

File, v políčku File vybrať súbor QGIS QML Style File a v časti Categories označiť nastavenia (pre 

symboliku Symbology, pre popisy Labels), ktoré sa načítajú z QML súboru a nakoniec kliknúť na 

tlačidlo Load Style: 
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Vrstva parciel C z AKO po pridaní do projektu: 
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Vrstva po automatickom nastavení symboliky a popisov z vybraného QGIS QML Style File súboru 

(ParcelC_symbolika_popisy.qml): 

 
 

 

QML súbory z návodu s nastavenou symbolikou a popismi pre vrstvy z AKO na stiahnutie 

Vytvorené QGIS QML Style File súbory s nastavenou symbolikou a popismi z postupov uvedených 

v tomto návode pre vrstvy katastra zo súboru GeoPackage stiahnutého z aplikácie AKO je možné 

stiahnuť tu: https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip 

 
 

Pre nastavenie symboliky bodov vytvorených z vrstvy ParcelC treba nakopírovať SVG súbory so 

značkami druhu pozemku a spôsobu využívania pozemku z usmernenia do priečinka (príklad pre 

QGIS verzia 3.28.3): C:\Program Files\QGIS 3.28.3\apps\qgis\svg\. 

 
 
 
 
 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip
https://www.gku.sk/files/sk/slovensky/ugkk/kataster-nehnutelnosti/technicke-predpisy-ine-akty-riadenia/usm_ugkk-sr_13_2013.pdf
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Popis QML súborov a ukážka nastavenej symboliky a popisov: 

• CadastralUnit_symbolika.qml 
o  nastavená symbolika pre vrstvu CadastraUnit 

 
• ParcelC_body_popisy.qml 

o  nastavené popisy pre body vytvorené z vrstvy ParcelC  

 
• ParcelC_body_popisy_biela.qml 

o nastavené popisy pre body vytvorené z vrstvy ParcelC v bielej farbe 

 
• ParcelC_body_symbolika.qml 

o nastavená symbolika pre body vytvorené z vrstvy ParcelC 

 
 



34 
 

• ParcelC_body_symbolika_biela.qml 
o nastavená symbolika pre body vytvorené z vrstvy ParcelC v bielej farbe 

 
• ParcelC_body_symbolika_popisy.qml 

o nastavená symbolika a popisy pre body vytvorené z vrstvy ParcelC 

 
• ParcelC_body_symbolika_popisy_biela.qml 

o nastavená symbolika a popisy pre body vytvorené z vrstvy ParcelC v bielej farbe 

 
• ParcelC_symbolika.qml 

o nastavená symbolika pre vrstvu ParcelC 
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• ParcelC_symbolika_biela.qml 
o nastavená symbolika pre vrstvu ParcelC v bielej farbe 

 
• ParcelC_symbolika_popisy.qml 

o  nastavená symbolika a popisy pre vrstvu ParcelC 

 
• ParcelC_symbolika_popisy_biela.qml 

o  nastavená symbolika a popisy pre vrstvu ParcelC v bielej farbe 

 
• ParcelE_body_popisy.qml 

o nastavené popisy pre body vytvorené z vrstvy ParcelE 
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• ParcelE_symbolika.qml 
o nastavená symbolika pre vrstvu ParcelE 

 
• ParcelE_symbolika_popisy.qml 

o nastavená symbolika a popisy pre vrstvu ParcelE 

 
• Zappar_symbolika.qml 

o nastavená symbolika pre vrstvu Zappar 

 
• Zappar_symbolika_biela.qml 

o nastavená symbolika pre vrstvu Zappar v bielej farbe 

 



37 
 

6. Export projektu do DXF 
 

Projekt s pridanými vrstvami s nastavenou symbolikou a popismi je možné vyexportovať do 

formátu DXF pomocou nástroja Project → Import/Export → Export Project to DXF 

(https://www.qgis.ch/en/projects/dxf-export): 

 
 

Po spustení nástroja sa otvorí okno DXF Export, kde vyplniť požadované parametre a kliknúť na 

tlačidlo OK: 

• Save as – zadať názov a umiestnenie výstupného DXF súboru. 

• Symbology mode: 

o No symbology – predvolená jednoduchá symbolika (väčšinou čierna farba). 

o Feature symbology - iba prvá úroveň symbolu (nie úplná reprodukcia pôvodnej 

symboliky). 

o Symbol layer symbology - pre úplnejšiu reprodukciu komplexnej symboliky objektov 

(zvoliť túto možnosť, ak majú vrstvy v projekte majú nastavenú symboliku a popisy). 

• Symbology scale – zadať vzťažnú mierku pre export vrstiev a ich symboliky a popisov (napr. 

1:300). 

• Encoding – v prípade potreby vybrať typ kódovania textu (prednastavený je CP1252). 

• Layer – označiť vrstvy z projektu, ktoré sa budú exportovať do DXF. 

 

https://www.qgis.ch/en/projects/dxf-export
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Vrstvy zo súboru GeoPackage z AKO v projekte s nastavenou symbolikou a popismi v mierke 1:300: 
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Ukážka vyexportovaného projektu v DXF v softvéri Autodesk DWG TrueView: 
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Vrstvy zo súboru GeoPackage z AKO v projekte aj s bodovými symbolmi druhu pozemku a spôsobu 

využívania pozemku pre parcely C v mierke 1:300: 

 
 

Ukážka vyexportovaného projektu do DXF v softvéri Autodesk DWG TrueView: 
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Vrstvy zo súboru GeoPackage z AKO v projekte s nastavenou symbolikou a popismi pre vrstvy 

ParcelyC a Zappar v bielej farbe v mierke 1:300 vyexportované do DXF a zobrazené v softvéri 

Autodesk DWG TrueView: 

 

Zobrazenie vrstiev v bielej farbe je vhodné použiť, ak sa pri práci v CAD softvéri používa tmavé 

pozadie. 

 

Upozornenie: Vyexportované DXF súbory majú nastavené ako meracie jednotky inches (palce).  

Je to z dôvodu používaného zdrojového súboru header.dxf (umiestnenie v QGIS verzia 3.28.3: 

(C:\Program Files\QGIS 3.28.3\apps\gdal\share\gdal\), kde je nastavené pri parametroch 

$MEASUREMENT=0 (English) a $INSUNITS=1 (Inches) 

Pre konverziu do jednotiek metrov treba tento súbor upraviť v textovom editore (napr. Notepad++ 

atď.) a nastaviť správne hodnoty pre parametre $MEASUREMENT=1 (Metric) a $INSUNITS=6 

(Meters): 

$MEASUREMENT 

70 

     1 

$INSUNITS  

 70 

     6 

Viac informácií o nastavených jednotkách v DXF súbore na stránke: 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html 

 

 

 

 

 

https://ezdxf.readthedocs.io/en/stable/concepts/units.html
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Už upravený súbor header.dxf je možné stiahnuť tu: 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip. 

Tento upravený súbor je následne možné nakopírovať priamo do inštalačného priečinku QGIS 

(príklad pre QGIS verzia 3.28.3: (C:\Program Files\QGIS 3.28.3\apps\gdal\share\gdal\) a nahradiť 

pôvodný, ktorý je predtým možné zálohovať premenovaním napr. na header_orig.dxf: 

 
 
 

7. Export mračna bodov a DMR do DXF 
 

Export mračna bodov do DXF 

Postup pre export mračna bodov do formátu DXF je uvedený v návode: 

https://www.geoportal.sk/files/zbgis/lls/navod-mracno-bodov-qgis.pdf 

Mračno bodov vo formáte DXF zobrazené v softvéri Bentley MocroStation V8i: 

 

 

 

 

 

https://www.geoportal.sk/files/qgis/qgis_export_dxf.zip
https://www.geoportal.sk/files/zbgis/lls/navod-mracno-bodov-qgis.pdf
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Export DMR a DMP do DXF 

Postup pre export digitálneho modelu reliéfu (DMR) alebo povrchu (DMP) v podobe vektorovej 

bodovej vrstvy alebo vrstevníc do formátu DXF je uvedený v návode: 

https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf 

Vytvorený DXF súbor zobrazený v softvéri Bentley MicroStation V8i: 

 
 

https://www.geoportal.sk/files/zbgis/lls/navod-pracu-dmr-qgis.pdf

